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Preface: 
 ACRORIP ™ is a Raster Image Processor designed to be used to print images with Direct to Garment (DTG), 

Direct to Film (DTF), and UV (Ultra Violate) flat bed and desktop printing systems. ACRORIP ™ is used to provide 

an easy-to-use interface to visualize the image’s position on a garment, page, or printing platen and make adjustments 

to the ink output and intensity/vibrancy of the image prior to printing, allowing for fine control over these settings for 

each ink channel independently of each other. 

 The term “RIP” is short hand for Raster Image Processor. What a RIP does is allows you to make fine-tuned 

adjustments to the overall visual look of an image for the purposes of printing. This includes adjusting color output 

brightness, contrast, the intensity of a given color channel to bring out the vibrancy of a specific color or to mute or 

reduce the output of another and adjust the layout of the image on the page or platen, allowing you to control the exact 

placement of the image. 

 

 ACRORIP ™ provides you with a constantly updated preview of the image you are working with as 

adjustments are made. ACRORIP ™ is a very powerful RIP software with the benefit of a simple and easy to use user 

interfaces. While there are many advanced settings that can help you to best adjust the visual quality of your prints, 

such as the ability to create  patterns from an image allowing you to repeat that image multiple times across a sheet of 

film, paper or many different objects placed on the printers platen, the ability to change the volume of ink that is used  

by each ink channel when printing, being able to adjust the intensity of a color channel independently of other color 

channels, or allowing you to utilize white ink in your printed images. ACRORIP ™ makes it easy to do these things 

and has exactly what you need from a RIP to make your prints stand out. 

 

  The manual is broken down in to several sections providing a detailed explanation of every feature that 

ACRORIP ™ provides. Some settings and features are fairly self-explanatory but some require a more in-depth 

explanation as they're usage and their settings aren't immediately clear upon first inspection. The aim of this manual is 

to provide all of the necessary information on ACRORIP ™ features, with insight provided as to how those features 

work and how they could be best utilized in your print work. to make you more comfortable, knowledgeable, and 

confident with the configuration settings of the ACRORIP ™ software from the simplest settings to the more 

advanced settings. 
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Icon Legend - 
  Several Icons are used throughout the course of the manual the following is a list of those icons and 

their intent. 
Marks critical information on the topic being discussed. Information provided after this icon may 

provide additional information or inform you as to risks or to raise awareness of issues when using 

certain settings for a given feature, and provide a solution to those issues if one is available. 

 

 

This icon is used to provide additional information on a feature that didn't belong in the explanation 

of the feature itself. Typically, the information provided after this icon will be very short. 

 

 This Icon is used when a tip on usage of a features is given, providing additional insight to the 

features use and how to properly configure its settings to get the best results from the feature being 

discussed. 

 

 

Installing ACRORIP ™ to your computer. 
 The company from whom you purchased the copy of ACRORIP ™ should have provided 

you with a copy of the ACRORIP ™ by some means, either on a USB Thumb Drive or by digital 

download. The Setup file should be named ACRORIP ™ Setup. Place this file on your computers 

Desktop and then double-click it to open it. If the company you purchased ACRORIP ™ did not provide you with 

the setup file you will need to contact them with the receipt for your order and they will then be able to provide 

you with the setup file needed to install ACRORIP ™ 10.33 to your computer. 

To install ACRORIP ™ 10.33 to your computer, you must have Windows 7 or later. During the 

installation process you may encounter a system popup or warning asking you if you would like to 

allow the setup program to modify your system. Click the “Yes” button and the setup process will 

continue. Clicking “No” will end the installation and close the setup program. 

 After allowing the setup file to modify your system you will see a pop-up window like the one shown in the 

image on the left. 

 

 If the “Create a desktop shortcut” check box is not checked, check it now and then click the “Next ->” button 

to proceed. 

 

 The setup will advance and display a summary of the actions it will perform. To proceed with the installation, 

click the “Install” button, to cancel the installation click the “Cancel” button. 

 

 Once you click the “Install” button the dialog window will display a progress bar like the one shown in the 

image below and information about files that it is installing to your computer. 

 

 Once the install has completed copying all of the files necessary for ACRORIP ™ to function the dialog will 

change providing an installation successful message and instructions on how to run the ACRORIP ™ program. You 
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can click the “Finish” button to close the setup program. 

 

 On your desktop there will be an icon on your desktop for the ACRORIP ™ software. 

 

 Double-click this icon on your desktop or under “DTGRIP” in your start menu to open ACRORIP ™. 

  

 

 Make sure you have the USB dongle that was sent to you with your order Inserted into a USB port on 

the computer you have ACRORIP ™ installed to or the software will display an error message stating 

it can not find a key lock. ACRORIP ™ will not load or function without the USB Dongle Key 

inserted into one of the USB ports on the computer you are using ACRORIP ™ on at all times. 

 

 Now that ACRORIP ™ 10 is installed on your computer we can continue on to the next Chapter on “Using 

the ACRORIP ™ User Interface” which provides and in-depth explanation of every section of the ACRORIP ™ user 

interface window the features provided by each section and information pertaining to their settings and usage. 

 

 

 

Using the ACRORIP ™ User Interface 
 The ACRORIP ™ user interface is broken down into several easy to understand and use sections each 

providing information regarding the image you are working with and the printer you will be using to print the 

image. In this section we will go through each of the user interfaces sections explaining each one and the 

information that you will find in it. 

 The following illustration provides an at a glance explanation of a number of the interface sections that 

are on screen the entire time you are using the program. Take a moment to review each of the sections of the 

interface to familiarize yourself with the lay out of the program. 

 

Illustration 1.A – ACRORIP ™ User Interface at a glance 

Using the drop-down menus. 

 This section provides information regarding the usage of the drop-down menu in the ACRORIP ™ 

window. Many settings can be adjusted using these menus, you can also perform basic printer maintenance such 

as print head cleanings and print nozzle checks. Keyboard short cuts that allow you to access the menu and its 

options quickly using the keyboard will be provided next to each menu item as they are being explained. 

 

Illustration 1.b – ACRORIP ™ Drop Down Menus 
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File Menu 
 

 (Alt + F) - 

The File menu option provides some basic options to configure your printer, 

the display area and to perform some basic printer maintenance like printing 

a nozzle check and performing a print head cleaning. The menu options under 

File will be explained below. 

  

 

Open (File) 
 

(Alt + O) - 

This menu option will bring up a dialog box which will allow you to open a 

number of image file formats including EPS (Encapsulated Post Script), 

PS(PostScript), PDF(Portable Document Format), BMP(Windows 

Bitmap),TIFF(Tagged Image File Format), JPG(Jpeg compressed image 

format), PNG(Portable Network Graphic), and PSD (Photoshop Data File).   

     

  
You can open a number of images in ACRORIP ™ at the same time, each being added to a thumbnail list display at the bottom of 

the user interface. 
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images that have a large file size due to the amount of uncompressed or RAW image data that is present can cause issues in 

ACRORIP ™ when converting the file into printer instructions because all of the information present in the image file will need to 

be converted, using files that are too large to store in memory during the conversion process can cause ACRORIP ™ to suddenly 

become unresponsive or crash. 

 

 

 

 

 

 

 

 

 

 

 

 

Reload 
  

(F5) - 

This menu item will allow you to reload all of the images you have open in ACRORIP ™ Acro at the time. If 

there had been any changes to these files the new information will be updated in the user interface to reflect 

them. 

Close 
 
This menu option will close the image that you currently have selected and are viewing in the 

user interface. 

Close All 
 
This menu option will close all images that you currently have open in ACRORIP ™. 
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Page Margin Setup 

 

This Menu option will allow you to set the page margins 

for your print job. Should you want the image to always 

be printed a certain distance from the top and left sides of 

the film. On this dialog there is a pull-down menu which 

will list all previously saved print margin settings that are 

available. 

 

To load a previous page margin setting you will select it 

from the drop-down menu and click the “Initialize” 

button.   

To change the current page margin settings, you will need to change the current values in the “Left” and “Top” 

edit boxes telling ACRORIP ™ you would like your margins to be placed at that measurement from the top 

and left edges of the paper. The values are entered using the measurement settings you have configured under 

the “Unit” setting under the “File” menu. 

 

You can save your page margin settings to be used again later by clicking the “Save” button and delete 

previously saved page margin settings by clicking the “Delete” button. Once you have your changes you can 

click the “Ok” button to commit the changed settings or “Cancel” to close the dialog with out committing any 

changes. 

 

Unit 

 

 This menu item allows you to set the unit of 

measurement that the software will use when dealing 

with measurements, the page layout area is the most 

notable of the areas that will be making use of this 

setting. You can select from Inches, Millimeter(MM), and 

Centimeters(CM). Once selected all existing 

measurements that you are using will be converted to the 

selected Unit size. 

Nozzle Check   
 

(F11) - 

This menu item will bring up the following dialog box allowing you to perform a print a nozzle check allowing 

you to see if there are any issues with clogged nozzles in the print head.  Clicking “Yes” will print the nozzle 

check and clicking “No” will cancel the operation. 
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Illustration 1.c – Print Nozzle Check Popup Dialog 
 

 

 

Head Cleaning 
 

(F12) – 

  This menu item will allow you to quickly perform a print head cleaning should your printer have any 

 clogged print nozzles. Clicking “Yes” on the following dialog that is opened will perform the print head 

 cleaning for your printer and selecting “No will close the dialog doing nothing. 

 

 

Illustration 1.d – Print Head Cleaning Popup Dialog 

  

Printout-size Revision 
 
 

  This feature is used when there is a difference between the size of the print and the size 

 configured in ACRORIP ™. If the size of the printed image is different than the size that is set in ACRORIP 

™ adjust  the print size to reflect the correct values here. 

Dry Mode 
 
- 

   This menu option will open the Dry Mode Dialog Box which will allow you to configure 

 ACRORIP ™ allow control of the print head of your UV printer to move the printhead further 

to  the left or right of the platen to so the UV light attached to it is able to fully pass over the platen 

 and reduce banding issues in your print. Information on using the “Dry Mode” feature can be 

 found on page 36. 
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Print (F10) – 

  This menu option will bring up the Print Dialog box which contains a summary of  the settings that 

 will be used to print your project allowing you to make some last minute changes to several settings before 

 printing. You can find information on using the Print dialog on page 39. 

 

Reload Printer Port  

(CTRL + R) – 

   This menu option will allow you to reload communications to the printer that you have configure 

 ACRORIP ™ to use on the Port that the connection to the printer is on. This may be necessary if the cable for 

the  printer had been disconnected and communications interrupted for any reason. 
  

Exit  

– 

  This menu option will exit ACRORIP ™ saving the currently open images and their configurations to 

 be opened the next time the ACRORIP ™ software is started.  
 

 

 

 

Edit Menu  

(Alt + E) - 

   The edit menu provides a number of options for aligning the image within the project design 

 plan as well as mirroring and rotating the image. The following is an explanation of each menu option found 

 under the edit drop down menu. 

 

 Left Top  

- 

This option will place the left top corner of the image in alignment with 

the top left corner of the page,or platen. 

Right Top  

- 

This option will align the right side of the image with the top right corner 

of the page or platen. 

Horz Center  

(Alt + E) + C - 

 This menu option aligns the image to the horizontally on the page or 

platen. 

 Vert Center  

(Alt + E) + V - 

 This menu option aligns the image vertically on the page or platen. 
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Center  

(Alt + E) + X - 

 This menu option centers the image vertically and horizontally on the page 

or platen. 

 Rotate  

- 

 This menu option will rotate the image 90 Degrees clockwise. 

 Mirror  

- 

 This menu option will reverse the apperance of the image on the page or 

platen 

Language 

Menu 

 

(ALT + L) – 

  The only language setting that is available in ACRORIP ™ is English, no other settings will  be 

found   under this menu. 

View 

Menu 

 

(ALT + V) – 

  The view menu contains additional settings for the  user interface of ACRORIP ™. 

Status  

– 

 This menu option will enable or disable the Status Bar which 

will be displayed at the bottom of the ACRORIP ™ window, this bar 

is used to provide information regarding the software’s status. 

  

Grid  

 – 

 This menu option allows you to configure the interval that 

the lines are drawn in the grid in the measurement setting  you 

configured under Unit in the File menu as well and setting, show grid 

and snap to grid settings. 
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 Show Grid  

- 

 This menu item will enable or disable the alignment grid 

within the page preview window. 

 
 

Snap To Grid  

- 

This menu item will enable or disable snapping the image to the grid 

when making adjustments to its placement on the page preview 

window. 

  

 

Illustration 1.e – Guidelines Dialog Box 
 

Guidelines  

- 

 This menu item will open the “Guidelines” 

dialog box. Within this dialog you can add a 

number of vertical and horizontal guidelines to the 

page preview window. To do this type a number 

that is within the size of the paper you have 

configured under the “Layout” tab and then click 

the “Add” button. You can change the location of a 

guideline by selecting it from the list, changing the 

value for it in the edit box and then clicking the 

“Move” button. You can remove a guideline by 

selecting it from the list and clicking the “Delete” 

or “Clear” buttons. When you click the “OK” 

button any guidelines you have set will be 

displayed on the page preview window. 
 

You can adjust the placement of any of the 

guidelines you have created by hovering your 

mouse over the guideline then left click and drag it 

where you would like to move it and then release 

the left mouse button. 

 

Lock Guidelines 

 

- 

Clicking this menu item will lock all of the guidelines you have placed on the page preview window preventing 

them from being moved until you unlock them. 

Template  

- 

This menu option will open the “Templates” dialog box where you can select and configure the settings for one 
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of three available templates to use in your project. You can find more information on this setting dialog on page 

41. 

Show Template  

- 

Using this menu option will display the template you have selected and configured under the 

“Template” dialog in the page preview window. 

 

Help Menu  

(Alt + H) – 

   This menu option will allow you to open the “About Program” Dialog which  

  displays information about the ACRORIP ™ software including version, Product-ID,  

   and copyright information. 

 

 

Illustration 1.f – About Program Dialog Box 
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ACRORIP ™ User Interface Explained 
 

 The ACRORIP ™ user interface is broken up into several areas each with its own purpose. The 

 areas of the user interface are shown in the image below and will be described in detail in this 

 section. 

 

 A lot of information is provided through the ACRORIP ™ user interface, providing you with an 

easy way to obtain information regarding the file you are working with. The main window of the 

ACRORIP ™ user interface provides you with the ability to move and resize the image on the page by 

clicking and dragging it around the screen in addition to providing a constantly updated preview of the 

image as you adjust it and make changes to the ink output and color curve adjustments.  

 

 

Illustration 2.a – ACRORIP ™ User Interface Window 

 
Almost all of ACRORIP ™settings are made through the panel on the right-hand side of the window, while it provides 
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a lot of information it is broken down into tabbed sections that are carefully organized to make it easy to use and to 

know which tab contains a specific setting option. As we continue, we will take and in-depth look at each of the tabs 

settings and how to use them. 
 

  

Image Preview Pane with Image Information 

 

 The image preview and information panel on the 

left side of the ACRORIP ™ user interface provides useful 

information about the image you have selected and are 

working with in the main window. 

 

 The following details are provided about the 

image. 

 

• Image Size – Is the height and width of the 

image measured in pixels. 

• Resolution -  Refers to the Dots Per Inch(DPI) 

of the image. This information is meant strictly 

for printing. The higher the resolution the more 

detail can be translated to the print. 

• Mode – The mode refers to the ICC Color 

Profile that the image used in it's creation and 

when it was saved which tells an image editor 

what color more to use to display the image 

accurately. 

• File Size – This refers to the size of the file in 

terms of KB (KiloBytes) or MB (MegaBytes). 

• Original Size – This refers to the original size of 

the image converted to the unit of measurement 

you have selected under the “Unit” option under 

the “File” menu. 

 

 

 

It is recommended to alter any large images that you may plan to print to reduce the images dimensions and file size to 

be as small as possible, while increasing the DPI of the image so that the detail and quality of the image is retained. An image with 

dimensions under 2000 pixels (~6.5 Inches) for either width or height and under several Megabytes(MB) s a good size to work 

with, Since you can scale the image up in  ACRORIP ™ we do not need to start with an image that is the size we intend to print 

out. 
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 Image Thumbnails  - 

 

 This area of ACRORIP ™ is on the bottom of the user interface and displays thumbnails of all of the images 

that you have open in ACRORIP ™ at any given time, allowing you to change which image you are working with on 

the fly. Right clicking in the Opened Image Bar will give you some basic functions for working with the image such 

as open, reopen,  close, print, etc. 

 Page Preview Panel 
  This area is in the middle of the ACRORIP ™ user interface and 

displays a white page with rulers set to the unit of measurement you have 

configured under “Unit” settings in the “File” menu, any guidelines you may 

have added to the projects page, and the image you are currently working 

with. 
  

  The Page Preview Pane allows you to move and scale the image 

anywhere within it showing you the location and the size of the image 

relative to the size of the page. Nearly all settings for the Page Preview will 

be made under the “Layout” configuration tab in the settings panel on the 

right side of the ACRORIP ™ interface. 

 

  

  

 

 

 Settings Panel - 
 This area is located to the right of the user interface and  provides all of the major configuration’s details of 

your project having four tabs of configuration options for  “Layout”, “Printer”, “Color”, and “White”, configuration 

settings are configured independently for each image that you have open. 
 
In the next section we explore the four configuration tabs that provide access to the majority of ACRORIP ™ features 

and settings. Each of the four tabs are carefully organized to make it easy to find the 

feature and setting you need to properly configure every aspect of your print job and printer. 
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To prevent yourself from having to constantly reconfigure settings such as the printer model, port, print resolutions and 

ink droplet size for every image that you open to work with, simply open ACRORIP ™ and without opening an image configure 

all of settings that you would like to be used by default every time you open ACRORIP ™ and once you have made all of the need 

changes close ACRORIP ™ and it will save those settings to the default job. When you reopen ACRORIP ™ it will use all of the 

previously configured settings and apply them to all future print jobs. 

 

Using the Settings Panel and Making Adjustments 

 Layout Settings Tab– 
  This tab provides you the settings for the layout for the print job providing you the  ability to make 

fine tune several aspects of the image on the page or print platen. At the top of the Layout page of the settings panel 

are buttons that allow you to perform the following page adjustments. 
 

 Image Alignment 

 

Move the image to the Top Left corner or the Page Preview screen. 

 

Move the image to the Top Right corner of the Page Preview screen 

 

Center the image to the page horizontally. This will take the image and place it in the center of 

the horizontal plane on the page. 

 

Center the image to the page vertically. This will take the image and center it on the vertical 

plane of the page. 

 

Center image to page. This will take the image and center it on both the horizontal and vertical 

planes of the page. 

 

Rotate – This will rotate the image clockwise by 90 degrees. 

 

 Mirror – This will reverse the image on the page so it is displayed and printed mirrored, 

this is good for DTF printing so when the image is placed ink side down on the garment the 

image will  display correctly on the garment. 

   

 

Open the print dialog to print the image. 
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Changing the  values “X” and “Y” will change  the starting point of the image on the page. The starting 

point of the image is the upper left corner of the image, and the starting point of the page is the upper left hand corner 

of the page or platen. 

 

Paper Size – 

 

Page 

Width 

 

- Allows you to set the width of the page 

or platen that you will be printing to. 

Page 

Height 

 

- Allows you to set the height of the 

page or platen you will be printing to. 

 

This setting is very important, if you set the “Paper Size” incorrectly the image will   not be able to be adjusted 

properly in relation to the page size or platen size you plan to print on and will not print in the correct location on the page or 

platen. Make sure the “Page Size” is set  to accurately represent the size of the page or printing platen you are going to be 

printing to. 

 

  

 Output Position – 
 

Output Position X 

Adjusting this setting changes the horizontal starting 

point of the image on the page or platen. 

Output Position Y 

Adjusting this setting changes the vertical starting point 
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of the image on the page or platen. 

 

  

Output Size – 
 

Output Width 

Adjusting this setting will change the width of the 
printed image on the page or platen. 

Output Height 

Adjusting this setting will change the height of the 
printed image on the page or platen 

 
 

 Scale –   

 

Equal Proportion 

This setting has two options. Selecting “TRUE” 

will keep the Scale of the image intact adjustingg 

the width and the height of the image with relation 

to their aspect ratio. Selecting “FALSE” will allow 

you to resize the width and height of the image 

without any change being made to the other 

dimension of the image. 

 Repeat –    

 

Repeat 

X 

By changing the value for this setting, 

you can add multiple copies of the image 

you are printing on the same row to be 

printed on the page or platen. 

Repeat 

Y 

By changing the value for this setting, 

you can add multiple rows of your image 

to be printed on the page or platen. 
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Distribute 
Top to Top 

 
Using this option will distribute the 

images using the absolute measurements 

provided by X and Y spacing. The values 

use with those settings will need to be 

larger than the size of the image or each 

image will overlap each other. 

  

 Spacing 

 Using this option will place the images 

spaced apart at a distance from each other 

set in the X and Y Spacing settings. 

 

 

X 

Spacing 

Changing this setting depending on the 

distribute option will either change the 

spacing using a distance from the left of 

the page or a distance from the right edge 

of the image f or the placement of the next 

image in the pattern. 

 

Y 

Spacing 

Changing this setting depending on the 

distribute option will either change the 

spacing using a distance from the top of 

the page or a distance from the bottom 

edge of the image f or the placement of 

the next image in the pattern. 

 

Pattern Pattern Normal 

Using this setting will tile the image in the 

pattern across the page exactly as the image 

is. 

Pattern Even Number 

Rotate 180 

Using this setting will rotate the image by 

180 degrees on even numbered rows and 

columns. 

The following are illustrations of the “Repeat” feature being used allowing for multiple copies of the image to be 

printed out on the same page or platen. This feature is extremely useful for Direct to Film and UV printing allowing 

you to make the most use of your film or allowing you to place multiple items on the platen to be printed. 
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Illustration 1. 

Image used as a pattern spaced apart by one 

inch using normal pattern setting. 

Illustration 2. 

Image used as a pattern using “Even Number 

Rotate 180” pattern setting. 

Always pay close attention to the Rulers on the page preview screen as it will keep you informed of the  page boundaries 

and the size of the image on the page allowing you to make precision adjustments to your image or pattern to ensure that they are 

placed well within the page. 

 

 

Printer Settings Tab – 
  The printer tab has a number of settings pertaining to the configuration of the printer.  There are 

several settings under this tab that are specifically aimed at the quality of the printed Image, such as the print 

resolution and the ink droplet size that is used for the color and white layers. 

 

Incorrect settings in this section could compromise the quality of the printed image or potentially 

cause damage to the print head of the printer depending on certain printing conditions 
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Printer Configuration Panel - 

 

Printer 

 This setting tell ACRORIP ™ which printer 

driver to use for the printer that you plan to print with. 

There are a number of driver options providing support 

for the use of many Epson printer models. 

 

Additional printer support is added as more 

printers are being used for the purposes of DTG, DTF, or UV 

printing. For a complete list of supported printers see the 

Appendix. 

 

 
The “RIP BOOST” option is specific to the Epson Stylus L1800 or 1390 printer and provides a performance increase allowing the 

L1800 to print faster than the normal provided driver by up to 40%. 

 

 

Many times, it is possible to use a printer that does not have a listed driver with ACRORIP ™. Some printers 

that are similar to a model number close in release often have the same or similar features and share the same 

drivers, making it possible to use an unsupported printer with a driver that is already available in ACRORIP ™. 

Please research the printer model you plan to use prior to attempting to use an unsupported printer in ACRORIP ™ 

as there is potential for the printer not to function with the driver for a different supported driver as some printer 

models even those release in succession sometimes have completely different features and printing options. For 

instance, the R1900, R2000, P400, XP-820 and a few other models make use of the same basic initialization 

commands and share a similar driver. Although the XP-820 has 1 less ink channel than the others it might be 

possible to use it by simply disabling the last unused channel. 
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Port 

This drop-down box contains a list of every printer and 

virtual printer that is present on your computer. When 

you read the list of printers that are available the first 

word is the port the printer is on and the words 

constrained with in < > is the printer as it is named by 

your operating system. 

 

 

  

 

Check Paper Size 

If set to “ON” this setting instructs the printer to check 

the page size of the paper that the images will be printed 

to. 

 

 Setup 

 

Resolution (White) 

 This setting changes the print resolution for the 

white layer of your print should you use one in your 

project. There are four different resolutions to select 

which will re-sample the image you are printing adjusting 

the Dots Per Inch (DPI) of the image that is going to be 

printed. 

 

 

Resolution (Color) 

 This setting changes the print resolution for the 

color layer of your print should you use one in your 

project. There are four different resolutions to select 

which will re-sample the image you are printing adjusting 

the Dots Per Inch (DPI) of the image that is going to be 
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printed. 

 

 
When changing the print resolutions you will also need to adjust your ink output as well to address the increased number of dots 

per inch in the image that are being printed and provide enough ink to   provide  a dense enough layer of ink  preventing the 

printed image from appearing dull or faint. 

The recommended base settings for the “Ink Limit Setting” in the “Color” configuration tab are 

 ~15-20% at 1440×1440 and ~25-30% at 2880×1440. These are considered to be the lowest necessary values to provide a quality 

print. These settings can be adjusted as necessary to further increase ink output providing a stronger  print quality. 

 

   
The quality of the detail in an image will not be increased by increasing the DPI of  either the color or white layers. It is 

recommended to use a DPI setting that is closest to the DPI of the image you are printing for the best results. Increasing the DPI 

of an image layer is not  the most effective way to increase the density of the layer that is being printed. To best achieve a denser 

layer of ink adjust the “Ink Limit” setting under the “Color” tab. Increasing the DPI will increase the print time for your image 

significantly as the printer will have to print more passes for each row of the image at higher resolutions. 

 

 

 

Feedin

g 

This setting refers to bow the page will be fed 

into the printer and needs to be set to Sheet 

for DTG and UV printing. 

Sheet 

Depending on your printer model you may have a few 

different feeding options available to select from. The 

Sheet option available to all printers tells the printer to 

feed a single sheet through it's primary feeder. For DTG 

and UV printers you would select this setting as the 

platen is controlled by the primary feed system of the 

printer. 

Roll 

The roll option is available for several Epson printer 

models allowing you to use a roll fed film or paper and 

cutter system with your printer. This option is only 

available for Direct to Film and paper based printing 

projects. 

 

 

  



 

Page 28 of 48 Copyright © and All Rights Reserved | ACRORIP.com ® | DTGRIP ® | DTFRIP ® 

Works only with Windows 7 / 8 / 10 

The “Roll” feeding option will allow you to best print large projects and can be used with the “Repeat” 

feature allowing you to print patterns across large print sizes. 

Speed 
 

 

 

This setting allows you to control the printing speed of 

the printer. 

 

 

Bidirectional 

This will cause the printer to print as the print head 

moves back and forth during the print operation. 

 

Unidirectional(L->R) 

This will cause the printer to print only as the print head 

passes from left to right during the print operation. 

 Unidirectional(R->L) 

This will cause the printer to print only as the print head 

passes from right to left during the print operation. 

Using UniDirectional printing actually provides a slight print quality increase, but will take significantly longer to 

print the image as the print head will only print when passing one direction. 
 

 

 

 

Wave 

 

The wave setting is used in UV printing only and is used 

to help prevent banding issues which are caused by a 

timing issue in the curing process of UV ink 
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This issue is known to occur most with printers that use a DX5 printhead for UV printing more so than those that use a 

DX7 printhead, enabling this setting will help to reduce banding issues in UV prints. 

  

  
 

 

  

 Ink Droplet (Dot) Size 

 

White and Color Dot Size Settings 

 The Ink Section allows you to  configure 

the ink droplet size for both the  white and color 

channels independently of each other. 

These configurations in combination with the print 

resolution will allow a finer level of control over the 

printed images detail. 

 

The following setting options are available. 

 

• Mix – This will have the printer use a mixture 

of all of the available droplet sizes when 

printing allowing for the best coverage while 

also being able to retain a finer degree of 

detail in the image. 

• Small – Will have the printer use only small 

droplets when printing. 

• Medium – Will have the printer only use only 

medium droplets when printing. 

• Large – Will have the printer only use large 

droplets when printing. 

• Medium + Large – Will have the printer use 

a combination of medium and large droplets 

when printing. 

• Small + Medium – Will have the printer use a 

combination of small and medium droplets 

when printing. 
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Using different droplet sizes allow for a higher quality print however the larger the droplet size that is used for printing will cause 

a slight loss in detail because the droplets will be too large for super fine detail in images such as photos. Using Large droplets to 

print images that contain little detail or used in the printing of the white layer as white ink is denser than color ink and may not 

jet properly using a smaller droplet size, which could cause damage to your print head.  Using “Mix” or “Small + Medium” 

droplet sizes for color output should provide the best overall quality for your prints allowing you to preserve as much detail in 

the image you are printing. 

    

While it is possible to set the ink droplet sizes for both white and color layers to large or  medium + large to try

 to get around issues with clogged print nozzles this is not the best practice as it could cause damage to the print head 

with prolonged usage with these settings damage could be caused to the print head depending on how many nozzles are clogged. It 

is strongly recommended to manually flush your print head with warm print head cleaning solution to remove blockages from the 

print nozzles instead of using a larger droplet size to compensate. 

 

 Color Settings Tab - 
   Color Tab allows you to configure the ink channels as well as multiple settings pertaining to ink 

output including the usage of ICC Profiles. This tab allows you to fine tune the output quality of the image by making 

adjustments to the ink channels as a whole or independently of each other. Applying a color curve adjustment to the 

ink channels as a whole or independently of each other, adjusting the brightness and contrast of the image and 

allowing you to use an ICC Profile to augment the ink settings to  better be used for DTG printing on cloth, DTF 

printing on film, or UV printing on a number of different substrates. We will discuss each of the available setting 

options that can be made on this setting panel to give you the best quality output for your project. 

  

 Print setting   

 

This option allows load previously used settings that you 

have created such as the cartridge configuration, ink 

output limit, color cure adjustments and usage of ICC 

color profiles. and allows you to make adjustments to 

them as necessary for your current printing project.   

 

There is a drop-down list box that contains the names of 

all of your saved printer  settings. To load an existing 

printer setting select its name from the drop down list box 

and click the “Initialize” button. 

 

 

To save changes that you have made to the output settings you can click the “Save” button and a dialog will popup 

allowing you to enter a name for the configuration to be saved as. 

 

If you no longer have a need for a output configuration you have save you can select it from the drop down list and 

click the “Delete” button and it will be removed from the list of available output settings. 

   



 

Page 31 of 48 Copyright © and All Rights Reserved | ACRORIP.com ® | DTGRIP ® | DTFRIP ® 

Works only with Windows 7 / 8 / 10 

 Ink Channel   

 

This setting tells ACRORIP ™ which cartridges in your 

printer are being used for which ink color including 

which cartridges are being used for White. 

 There is a drop-down list which initially only contains a default ink channel configuration for the printer 

model you have selected under the “Printer” settings tab. This drop-down will also contain any saved cartridge 

configurations that you save for your printer. To the right of the drop-down list box there is a button labeled “Setup”, 

clicking this button will bring up a dialog box that will allow you to configure the ink channels of your printer. 

 

 
 When the Ink Channel Setup dialog is opened you will be provided with number of  dropdown list boxes that 

will allow you to assign what colors are on each channel. You have full  control over what color is assigned to each 

channel allowing you to place them anywhere.   

 

 Once you have configured each of the ink channels you can click the “Save” button to save the configuration 

for later use.. To delete a previously saved configuration, select it from the drop-down list box at the top of the dialog 

and then click the “Delete” button and it will be removed from the list of available ink configurations. Once you have 

made changes and saved them you can close the dialog by clicking either the “Ok” or “Cancel” buttons 

 

Because you can assign any color to any cartridge slot you want you can easily group your inks by type for instance 

creating a cartridge configuration that groups Cyan, Magenta, Yellow, and black together and then grouping all of your white 

cartridges together in a configuration like CMYK+WWWW to make it easier to maintain and manage your inks. 
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 Ink Limit – 

 

The Ink Limit area of ACRORIP ™ is often called “Ink 

Choke” in other RIP software. The purpose of this 

function is to control the volume of ink that is used 

during the print process allowing  you to either decrease 

or increase the amount of ink that is used. 

 

These settings can be changed for all of the ink channels 

universally by selecting the box of color bars or they can 

be changed for each channel independently by clicking 

the radio button next to each color and changing the 

numbers in the edit box. 

 

 The default ink limit settings are a good starting point to 

test the print quality of the image making adjustments as 

necessary until you reach a configuration that best suits 

your project. 

 

 
The ink limit for white is often higher than color inks to provide a denser layer of ink to be printed to act as a solid backing for the 

color layer on dark garments or objects. 

 

If you are wanting to make a specific color channel more intense or less intense in your image adjust the 

color curve for that specific color channel, applying a same color curve adjustment to all of the color channels will 

produce an undesired effect by making that adjustment apply to the other colors as well which will not have the 

intended result. 

 

For the best results you want to use the lowest possible values that provide a dense layer of ink on your film, garment 

or object. It is possible to print to much ink to the surface of the object which could compromise the quality of your print. In cases 

such as DTF printing and UV printing as the volume of ink on the object increases it can start to pool allowing the ink to migrate 

within the print causing colors to blend together and potentially causing the white layer to start mixing with the colored layer 

below compromising the overall quality of the print. The recommend values are ~15-20% at 1440×1440 DPI and ~25-30 for 

2880×1440 DPI. You may want to use slightly higher values for white so there is a denser layer of white over the color to act as a 

strong backing to your color layer. These values are provided as a guideline for the lowest values to provide a reasonably dense 

layer of ink output and can be adjusted as necessary to provide the highest quality print. 
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 Ink Curves Adjustment 

– 
   
The Curve graph allows you to adjust the intensity of the ink 

channel you apply the curve to and can help you to make an image 

more vivid by making certain colors stand out more by adjusting the hue and gamma values for each channel. 

 

 The curve grid has two planes the vertical plane represents the input value for the vector and the horizontal 

plane represents the output value for the color that is being adjusted. 

 

 By raising the vector to the top left we are adjusting lower hues in the color channel to be much higher 

causing them to be more intense and vibrant. If we were to move the vector to the bottom right, we would be adjusting 

all hues of the color channel that is being adjusted to be much lower effectively reducing its presence from the image 

 

 Clicking anywhere on the curves line will   add a point, which can be moved anywhere in the adjustment grid 

to add a point of adjustment to the curve based on the input and output of the vectors place on the curve providing a 

finer degree of adjustment for the colors. Right clicking any of the dots on the curve will remove it from the curve. 

 

  The higher the point is on the grid the darker the hue of the color that is being adjusted will be and the lower 

it is on the grid the lighter the hue will be.  The further to the right on the grid the point is placed the lower the output 

value will be for the channel that is being adjusted, the further the dot is to the left the higher it will be. You can add 

multiple additional points to the curve for finer control over the vibrancy and intensity of a given color. 
 

 You can apply a curve to each color channel by selecting the ink channel you want to adjust from the options 

in the “Ink Limit” section above the curve grid.  Clicking the link button to the right of the curve grid will apply the 

curve adjustment you are editing to all color channels. 

 

 Brightness and Contrast – 

 These settings allow you to adjust the  intensity of 

how luminous the image is while contrast allows you to 

adjusts the contrast of the image allowing you make the 

differences in  color and detail more or less noticeable. 

 ICC Profiles – 

 This setting will allow you to enable/disable the use of ICC Profiles. Clicking the “ICC Profile”  button 

will open the ICC Profile Dialog window 

. 
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By checking the “Use” checkbox you can enable the use 

of predefined ICC Profiles that are available for the 

Stylus 1390, Stylus L1800, and the Sure Color P600. 

 

Each ICC Profile has several different intent 

configurations to adjust the print quality of your images, 

 

  

 

ICC Intent Options 

The following ICC Profile Intent configurations are available for use. 

• Perceptual (Photo) – Changes all of the colors in the image to a relative color in the CMYK color 

gamut allowing the printer to print the image with quality that is closest to that of the image being 

displayed on your screen. 

• Relative Colorimetric – Changes all of  colors in the image especially those that are out of the 

CMYK color gamut of the printer to the nearest approximate color that is in the CMYK color 

gamut. 

• Saturation – Keeps the saturation levels of the colors in the image intact while adjusting other 

factors of the colors in the images color gamut such as the hue and the gamma value of the color to 

better fit the smaller color gamut the printer uses. 

 

 

  
While the ICC Profiles maybe designated for a specific printer model they may be usable with other printer models and even for 

DTG and UV printing. 

 

 The term “gamut” when referring to color spaces on your computers display or printer describe the range of colors 

that are available to either your display on your computer or the range of colors that are available on your printer.  Because the 

CMYK color gamut the printer uses is significantly smaller than the sRGB color gamut that of your computers display color 

reproduction will not always be exact as the printer can't accurately reproduce a large number of colors that are available in sRGB. 

The purpose of an intent within ICC Profiles is to allow a number of ways to best attempt to recreate them within the color gamut 

that the printer has. 

 

 



 

Page 35 of 48 Copyright © and All Rights Reserved | ACRORIP.com ® | DTGRIP ® | DTFRIP ® 

Works only with Windows 7 / 8 / 10 

White Layer Settings Tab 
 
 The White Ink Control Tab allows you to configure the usage of white ink in your prints and has many 

configuration options to control the several aspects of using a white layer in your print. Every change that is made to 

the settings on this settings  page will update the page preview screen. 

 

 

White Layer Generation – 
  This drop down box Several methods to 

generate a white layer to provide a backing to your prints 

on dark objects so the color layer will stand out against 

the darker object. The following white layer generation 

options are available.  

Fill all Area 
 Will print a white layer the size of the image. See 

Illustration A.  

100% White Under Any 

Colored Pixel 
 This create a layer that places a white pixel any place a 

colored pixel is present. See  Illustration B. 

Gradient White Under Any 

Colored Pixel   
This will create a gradient white output for every colored 

pixel in the image. You can use “White Ink Curve 

(Gradient White) setting to adjust the level of detail the 

gradient applies to, the gradient only applies to shades of 

black and gray a white mask is created for all other colors 

in the image. See Illustration C. 
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Illustration A – Fill all Area Illustration B – 100% White Under 

Any Color Pixel 

Illustration C – Gradient White 

Under Any Colored Pixel, with 

Gradient Curve Adjustment. 

 White Gradient (Negative) –   
 This setting will create a white gradient negative of the image A. Negative image will make dark areas 

 white, white areas black, and other colors a shade of gray. See Illustration D. 

 White Gradient (Positive) – 
 This selection will create a white gradient positive for the  image. A positive will make the dark areas 

 black and the lighter areas white and any other color a shade of gray.  See Illustration E. 

 Spot Color (TIFF RGB) – 
 Will create a white positive mask for any non-transparent pixel that is in the TIFF RGB color space. 

 
  

Illustration D Illustration E Illustration F 

 

 

 

 

 

 

 
Lowering the threshold to low will cause  the feature to remove other dark hue colors from the image in addition to removing 

black. Be cautious when adjusting the “Black Detect Threshold” feature. 
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Black Handling 
This configuration option allows you the option to detect and remove black ink from being  printed  in your project, 

in the case of black shirts this can save you a lot of ink and money. 

 

 

Black Detect Threshold 

  The lower the setting the more shades of black 

will be detected by ACRORIP ™. You can see what is 

removed in real time in the Page Preview window. 

Remove Black and set to 90% 

This setting will remove all of the black with in the 

threshold that you have set from the printed image. 

 

 
 

 View 

 

From here you can see the preview for white and color 

layers and a preview of both layers combined. 

The Page Preview window of the ACRORIP ™ interface 

will automatically update as you change preview modes. 

 

 

  

 

 

 

  White Channel Settings – 

  

 

Clicking this button will open a dialog window with 

several buttons with a Check Mark image 

on it. These buttons represent the ink channels that you 

have configured for white ink. The more 

cartridges you have assigned to provide white ink the 

more buttons there will be on this dialog. 

There may be several reasons to disable a white ink channel. For instance, the line maybe clogged, the cartridge may be 

damaged and unusable, you may have run out of ink on that channel, you may be using one of the white channels for something 
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other than ink and may not want it to be used during normal printing operations. 

  

   

 

 

To disable a white ink channel, click the button that represents the ink channel you don't want to be used and the 

button will change to have a “Strike Out” image on it.  To close the dialog, click either the “Ok” or “Cancel” button. 

 

  

 

 

 

White layer Offset Configuration 

 The final configuration at the bottom of the page is to 

adjust the white layers print size offset with relation to 

the color layer. For every pixel it changes the offset for 

the white layer up to 20 pixels per side. This feature is to 

allow you to keep the white layer from overlapping the 

color layer causing the color layer to be outlined in white. 

By adjusting the offset, you are telling ACRORIP ™ to 

move the outer edges inward and within the boundaries 

of the color layer. Check the “Except White Only” to 

apply the offset to the white layer of the print. 
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Dry Mode Dialog 

  When using a UV printer the UV light that is used to cure the varnish UV ink is   attached to the  the print 

head so the varnish UV ink can be cured while it is being printed. Unfortunately the way that the light is mounted can lead to an 

issue when curing the ink which results in weak areas of the print because the light while printing depending on which side of the 

print head the light attached to it will not travel far enough to fully cover the full width of the printed area because the print head 

naturally only travels far enough to print the ink on the item on the platen preventing the light from passing over  the  furthest 

most left or right side of the platen. To resolve this issue this setting has the printer print a thin line extended out beyond the end 

of the designated printing area on the platen allowing the UV light to pass over all areas of the platen reducing the potential for 

weak uncured areas in the print. 

 

 

 

 

 

 

 

 

 

Illustration 3.A – Dry Mode Configuration Dialog Box 

 

   In the Dry Mode dialog that is displayed you can configure the distance  that the print 

head will need to travel to the left or right to properly place the light over the full width of the printing 

platen during  printing allowing for a complete cure of the  printed ink. To enable the use of this feature 
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you will need to check the “Print Left Right Guidelines Check Box” 

 

Left Line and Right 

Line Dry Mode 

Settings 

Left Line and Right Line 

Position 

The line position can be adjusted by changing the values 

present in the “Position” edit boxes. The line will be 

printed vertically running down the side of the platen. 

Left Line and Right Line Color 

To change the color of the line that is printed click the 

color selection drop down menu below the position edit 

boxes. You will be able to select a color from the box that 

appears. 

When setting the position of the Left and Right Line options remember this line should be placed on the furthest ends of 

the print platen and your images should be placed within them with some space between the Left or Right Line so that the print 

head will travel far enough past the printing space to provide coverage from the UV light. 

 

 

Line Width 

You can change the width of the line that is printed for 

the Left and Right Line setting by changing the value in 

the edit box here. This feature has a range of 1000/th of 

an inch up to one inch. 

 

Add Length 

To set the length of the line running down the left or right 

side of the platen change of the edit box here. 

 

UV Dry Mode (Left) 
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Checking this box tells ACRORIP ™ that the UV light is 

mounted on the left side of the print head and will enable 

the “Draw Left UV Line” setting. Leave unchecked if it 

is on the right side. 

 

 

 

Draw Left UV Line 

If you have the “UV Dry Mode(Left) setting checked this 

setting will be enabled allowing you to to have ACRORIP 

™ draw a line down the left side of the Page Preview. 

 

 

Illustration 3.B – Draw Left UV Line setting 
When using this setting a line is drawn on the left side of the page preview screen along with a blue tinted region 

which indicates the area that the print head will not reach during the printing process. 

 

 

 

 

 

 

 

Print Dialog -   
On this dialog it will provide you with information regarding many settings that will be used to perform your print. 

The information provided covers things like the printer that will be used to perform the print, ink output settings, page 
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settings and so on. 

 

● Output Position - The starting point 

of where the image will be printed on 

the page. 

● Output Size – 

 The dimensions of the image being 

printed. 

● Page Margin –  

The Top and margins of Left margins 

for the page. 

● Printer –  

The print driver that is being used to 

control the printer. 

● Port – What port the printer is 

connected to the computer on with the 

model of the printer encapsulated in 

<> 

● ICC Profile – Whether or not an ICC 

color profile is being used or not. 

● Ink Limit – Provides the values used 

for the ink output of the print. 

● White Channel – Tells you which 

white channels are enabled to be used 

for the print job. 

 

 There are two group boxes named “White Setting” and “Color Setting” which provide information on the 

resolution settings that are being used to print the white and color layers and allow you to set how many copies of 

each you would like to print. 

 

 

 
Because the delay between print passes is fairly short using the longest wait time will not increase the print time of the image 

significantly. 
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 Drying Time - 

 

The Drying Time Per Print Head Pass drop down box 

setting allows you to set a delay in how quickly the print 

head passes to print a row of ink. This allows the ink to 

dry a little during the printing process. This setting is 

only available on a hand full of older large format 

printers and may not be available for your printer model. 

 

This setting is measured in increments of 1/10th of a 

second 

 

 

 

 

 
At the bottom of the Print Dialog there are a series of check boxes depending on if you have white ink enabled in your 

Ink Cartridge configuration or not. If you do have white ink configured in your Ink Cartridge settings you will see the 

following. 

  

Color and White Print Order and Single Pass 

Print Option 

 

Print Color First White + Color 

This setting when checked will have ACRORIP ™ print 

the color layer of your image before it prints the white 

layer. 

This setting when enabled will tell ACRORIP ™ that you 

would like to print an image that contains both a colored 

and a white layer and to print them at them both in one 

pass. 

 

 

 

Depending on the number of copies you have set in the “White Setting” and “Color Setting” changing the “Set Copies” 

setting will print out that many white and color copies as part of a “Set” This setting must be no less than 1. 
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Tumbler 

Changing this setting will reduce the number of print nozzles that are used to print with for both black and color ink 

channels. 

 

 
Using a lower number of print nozzles will provide better print quality in graphics that have narrow lines and detail in them as 

can be the case with Vector image-based images.  Please note that using a lower number of print nozzles will increase your print 

time. 

 

 

 

 

Set Copies 
Changing this setting tells the software how many total times you would like to run the print job for your image. 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Template Dialog 
 

The template dialog has a number of templates available to use in your project and those templates can be adjusted a 

number of ways to best suit your project’s needs. Below is a list of the available templates you can use and an 

explanation of their settings. 



 

Page 45 of 48 Copyright © and All Rights Reserved | ACRORIP.com ® | DTGRIP ® | DTFRIP ® 

Works only with Windows 7 / 8 / 10 

 
Shirt Template 
The first in the shape of a shirt collar is for DTG (Direct 

to Garment) printers allowing you to define the 

boundaries for a shirt which will allow you to pre-

visualize the placement of the image on the shirt in 

relation to each of the sides and the neck of the shirt. 

 

 Rectangle Template 
The Next template shape is a rectangle, this option is 

perfect for DTF (Direct to Film) or UV printing systems 

to define the placement of images on a page or on the 

print platen.  The size can be adjusted to create squares or 

rectangles. 

 

 
Ellipse Template  
The final predefined shape is an ellipse. The elliptical 

pattern is great for when you have an oval or circular 

object to print to allowing you to get the placement of 

your image placed properly with in the object. The 

Elliptical pattern can be adjusted to be either an oval or a 

circle. 
 

 

 

The placement and size of the templates can quickly be changed to fit your needs for each of your  printing projects. 

The collection of settings below the template selection are used to make those adjustments,  and will be using the unit 

of measurement you had selected under “Units” in the File menu.  

 

 

 

 

 Template Settings 

 
Start X and Start Y 

These edit boxes allow you to configure where the 

starting point of the template is in relation to the top left 

corners of the page or platen.    
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Width and Height - 

These edit boxes allow you to configure the size 

of the shape with in the page or platen. 

 

  

 The next set of edit boxes allow you to use  set the 

 template as a pattern across the page or platen, this feature 

 is to be used with the “Repeat “feature under the “Layout” 

 Tab of ACRORIP ™ which allows you to print several 

copies  of the image across the page or platen. The output 

of   which can be seen in the image on the left showing 

 several rectangles tiled across the page display. 

  

 

 

 

 

Changing the values for “Interval X and Y” as well as “X and Y Steps” will change settings for 

the repeat feature under the “Layout” tab showing additional row and columns of the image along with 

the template guidelines. 

 

 

 

 

 

 

 

 

 

Interval X and Y 

allows you to set the distance apart the template 

should be placed from one another. 

 

X and Y Steps 

allows you to repeat the template guideline a 
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number of times vertically and horizontally. 

 

Angle - 

allows you to orient the template on the page in 

increments of 90 Degrees. 

 
Line Width - 

allows you to make the outline of the template 

normal or bold. 

User Defined Templates Settings 
The section below the template settings is used to to manage saved template settings. Here you can load 

previously saved template settings by simply selecting the save template  settings by selecting it's name 

from the list box.   

 

 

Saving Custom Template Settings 

To save your template settings simply click the “Save” button and you will be presented  with a 

small dialog allowing you to enter a name for your template settings allowing you to r euse them later 

for other projects. 

Delete Custom Template Settings - 

To delete a previously saves template configuration, select the template configuration from the 

list box and click the “Delete” button and it will be removed from the list. 

Rename Custom Template Settings - 

 You can rename a previously saved template configuration by clicking the “Rename” button. A 

small dialog will popup allowing you to change the name of your save template configuration. 
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 On the other side of the dialog, you can click the “Apply” button to apply the template settings 

your created, clicking “OK” will also perform the same task and close the dialog, and “Close” button 

will close the dialog without any template settings being applied to you page preview unless you had 

previously clicked the “Apply” button. 

Appendix A: Printers supported by the current version of ACRORIP ™ V10.33: 
• RipBOOST® (Modified Driver for the Epson Stylus L1800 printer model which 

increases the print speed by up to 40% 

• Epson EcoTank L800/L805 

• Epson Stylus Photo 1390 

• Epson Stylus Photo 1400 

• Epson EcoTank L1800 

• Epson Photo XP-15000 

• Epson Stylus Photo R1900 

• Epson Stylus Photo R2000 

• Epson Stylus Photo R2400 

• Epson Stylus Photo R2880 

• Epson Stylus Photo R3000 

• Epson Stylus Pro 3000 

• Epson Stylus Pro 3880/3885 

• Epson Stylus Pro 4000 

• Epson Stylus Pro 4880/4890 

• Epson Stylus Pro 4900 

• Epson Stylus Pro 7800 

• Epson Stylus Pro 7880 

• Epson Stylus Pro 7890 

• Epson Stylus Pro 7900 

• Epson Sure Color P400 

• Epson Sure Color P600 

• Epson Sure Color P800 

• Epson Sure Color P5000 

• Epson Sure Color P6000 

• Epson EcoTank ET-8500 

• Epson EcoTank ET-8550 

Support for additional printer models is being added to ACRORIP ™ regularly to expand support for other 

Epson printers that are used to create DTG, DTF, and UV printers. 


